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Copyright Information

All rights reserved. No part of this publication may be reproduced, transmitted, stored in a
retrieval system, or translated into any language in any form by any means, mechanical,
optical, eiectronic, recording, or otherwise, without the written permission of Mustek,
Incorporated.

Mustek Incorporated reserves the right to revise this manual and to make changes to any or
atl parts at any time, without obligation to notify any person or entity of such revisions and

changes.

Mustek is a registered trademark of Mustek, Incorporated. All other brand ar product names
mentioned in this manual are trademarks or registered trademarks of their respective

OWTICTS.

Copyright © 1998 Mustek, Incorporated.
Printed in Taiwan, April 1998.

FCC Statement

This digital equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to pravide
reasonable protection against harmful interference when the equipment is operated in a
residential instaliation. This equipment generates, uses, and can radiate radio {requency
energy and if it is not installed and used according to the instruction macual, it may cause
harmful interference to radio communicatiens. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment causes harmful
interference ta radio or television reception, which can be determined by tuming the
equipment off or on, you are encouraged to try o correct the interference by one or more of

the following measures:
+ Rearient the receiving antenna
- Increase the distance between the equipment and the receiver

« Connect the equipment into an outlet on a circuit different from that to which the receiver

is connected

« Consuit the dealer or an experienced radio/TV technician for help

NOTE

1. The changes or medifications not expressly approved by the party responsible for
compliance could void the user’s authority to operate the equipment.

2. Shielded interface cables.and AC power cord, if any, must be used in order to comply
with the emission limits. :
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Instaliation

This chapter covers the scanner parts and describes how to connect
the scanner to your computer and printer. You will also find
information about the operation of the scanner.

Unpacking the Scanner Package

Carefully unpack the contents of the scanner package. Inspect the
iterns closely and if you find any itemn damaged, please contact your
dealer immediately. Also, save the box and packing material for
future use in case you have to ship the unit.

The Scanqner Parts

B
Qocument
Cover

Scan Window
Glass
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Connecting the Scanner to the PC and Printer

Refer to the following illustration and steps to install your scanner.

1-2

wn

Power off the computer and any devices that are connected to it
(e.g., monitor, printer, modem}).

Disconnect the printer cable from the printer port in the back of
your PC.

Take the disconnected end of the printer cable and attach it to the
port in the back of the scanner for the Printer. Tighten the
retainicg SCrews.

Connect one end of the scanner cable to the printer port in the
back of your PC and tighten the retaining screws.

Cornpect the other end of the scanner cable to the port in the back
- of the scanner for the Computer.

Connect the power adapter to the scarner and plug it into an
appropriate power outlet.

Power on the computer and wait for the computer to finish
booting.

Install the scanner driver and software by referring to the next
section.

-
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[nstalling the TWAIN Data Source

Windows 85/NT Route

Begin by inserting the
Mustek 600 CP CD.

Follow all on-screen instructions.

Note: If your Autorun feature is
disabled please refer to the following
instructions.

Click on “Start”

In the “Run” dialog box, type
“drive:\run” where drive is your
CD-ROM drive and click “OK.”

Foilow all on-screen mstructions.

and select “Run".

Windows 3.1x Route

Begin by inserting the
Mustek 600 CP CD.

, 7’| From Program

o TFRT “{ Manager, click on

. | the “File” menu
and select “Run’.

In the “Run” dialog box, type
“drive:\run’ where drive is your
CD-ROM drive and click “OK.”

Follow all on-screen instructions.

" Note: Do not use the "add hardware" icon to install your scanuer.

&

Instalfation 1-3
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Scanning Tutorial

There are two separate metheds to scan an image: the Scan dialog
box, which is ideal for quick and simple scans and the TWAIN
dialog box, which offers more control over the output.

This chapter skows you how to:

1. Get (Acquire} and Use the Scan Dialog Box

2. Get (Acquire) and Use the TWAIN Dialog Box
3. Perform a Simple Scan

4, Position a Document

3. Scanmning Tips

(Acquire) and Use the Scan Dialog Box
(For Windows 95 & Windows NT Ounly)
You can access the Scan dialog box in two ways.
1.The Direct Scan Icon: Simply double click the left
Mouse Button on the Direct Scan icon that is located in your
Windows notification bar.

2 The Cover Sensor Dialog Box: This scanner is equipped @
with a Cover Sensor feature that takes you directly into
scanner access mode. Simply lift the cover of your scanner
ard the Cover Sensor dialog box will appear. To proceed to
the Scan dialog box, click "Continue".

This Cover Sensor dialog box can be disabled by selecting
the disable feature. By doing this the Cover Semsor takes
you directly to the Scan dialog box, bypassing the Caver
Sensor dialog box. To re-enable the Cover Sensor dialog box.
click the right mouse button while on the Direct Scan icon in
your Windows Notification Bar. A pop-up menu a2ppears
allowing you to re-enable the Cover Sensor dialog box as
well as disable or re-enable the Cover Sensor feature.

Scanning Tutorial 21
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2.2

The Scan Dialog Box

The Scan dialog box allows you to perform several functions using
your scanner (e.g. scan, copy, fax). Simply select the function that
you wish to use by clicking on the appropriate page icon and the
corresponding menu page will appear. Be sure to make the proper
adjustments in regards to Paper Size, Scan Mode, and/or Resolution

before Scarming.

Scan

Sean [he imoge to the Comauiss

a7

Menu Page

Scan Page:

Copy Page:

Fax Page:

E-Mail Page;

OCR Page:

Fiatbed Scanner User's Guide

Copies the image or document.

_@_

Browse Icon

Scans the image or document to the computer.

Scans and faxes the image or document.

Scans and sends the image or document to the Internet

Converts the image document to a text file
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Scan:

Scans the image or document and allows for various features
depending on the Menu Page that you are currently in.

Copies vour image or document to your printer in Capy Page.
Faxes your image or document in Fax Page.

E-mails your image or docurnent to the internet in E-mail Page.
Scans the document for editing into your OCR software in OCR

Page.

Exit:
Exits the program.

Help:
Offers available on-line help for all of the scanner and software

functions.

-

About:
Shows product information.

The Browse Icon: This icon allows you to select the software
application you would like to open the scanned image into.

Scanning Tutorial




&) Get (Acquire) and Use the TWAIN Dialog Box

You can call up the TWAIN dialog box from within any TWAIN-
compliant software such as the application software bundled with the
scanner. To get inte the TWAIN dialog box, the steps are:

1. Launch Windows.

2. Launch the TWAIN-compliant program {e.g. iPhoto Plus 1.2 or
4.0). :

3. Under the File menu opea the Acquire command and choose
Select Source. The Select Source dialog box appears.
Note: In some image editing software you may choose Select
Source directly fram the Select Source command rather than the
Acguire command.

Sources:
CMUSTERSODCP:-- - -0

}_

Coneet |

L ]
4. Choose your scanner in the Select Source dialog box. If there is
only one source available, it is automatically selected.

5. Click the Select button. The Select Source dialog box closes.

6. Retum to the File menu. Locate and click the Acquire command.

The Acquire command is likely to be found beside the Seiect

command.
The TWAIN dialog box appears.

24 Flatbed Scanner User's Guide
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Scanner

The TWAIN Dialeg Box

Batch Scan Button Zoom Buttons
Allaws creation af upto 10 Single Scan Button Magnifies or shrinks the
scan regions (or Crop Frames) Allows oniy one Crop image in the Preview

for muitiple scanning. Frame o scan region. Windaw.

28] £ Help
; é | Language Box
Selects the language

Exits the program
Cantrols 7 | - w7
= Prescan Button
Scan Button
Descreen Button . Crop Frame
- Reduces image  Preview Window Outlines the image area or region
naise or pattemns. that will be inciuded in the final scan.

The TWAIN dialog box consists of two sections - the left section
where most of the TWAIN control settings are found and the right
section, which is the Preview window.

Scanning Tutorial 2-5




@ Perform a Simple Scan

T omanls’
BEaa0 .
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The steps to follow when scanning are:

1. Select the scan size.

I~

Prescan the image.

3. Using the crop frame set the desired scan image size.
4. Select the desired scan mode.

5. Select the desired resolution.

4. Click on the Scan bution.

These steps are explained in detail in the following sections.

Select the Scan Size

From the list of available paper sizes, select the size of the docurnent
you wish to scan. Custern will automatically be selected when you
use the Crop Frame to change the image area to be scanped.

Prescan the Image

A Prescan is a quick low-resolution scan of the entire original image.
From this low-resolution scan you can get a clearer idea of the image
area you want to include when you click Scan. To prescan, the steps

are:
1. Piace the document face down on the scan window glass.

2. Click on the Prescan button. After the scanner has scanned the
document, the scanned image will appear in the Preview Window.
From the Prescan image, you can now set the exact tmage area you
wish to include in your final scan.

Set the Image Size

Use the Crop Frame in the Preview Window to outline the image area
you wish to scan. Click one of the sides or corners of the Crop Frame
and drag it to the desired length and width. To move the entire Crop
Frame, position the mou®e cursor inside it and drag with the (left)
rmouse buttor. Only the area inside the Crop Frame will be included
in the resulting scanned image when you click on the Scan button.

2-5 Flathed Scanner User's Guide
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Using the Zoom Tools

The Zoom In toal doubles the magnification of the image area. In
magnified view, you can then drag the Crop Frame to the exact area
you want to scan. Use the Zoom Out tool to shrink the image.

Set the Scan Mode
The Scan Mode determines how the scanner will read the image.

Select Color to capture images in color. Select Gray to capture
images in shades of gray. When you wish to scan line art or text for

OCR (Optical Character Recognition), select LineArt.

Set the Resclution

The Resolution, which is measured in dots per inch {dpi) determines
the effect of the image as it is displayed or printed. Images scanned at
a high resolution appear sharp sirce the scanner is capturing more
information but take note that high resolution images also take up

more disk space for storage.

Execute the Scan

The scan button is used once you have completed the prescan
and are finished with the control settings and have selected the final
image adjustments that are to be used for this scan.

Note: To further adjust your image before scanning see Chapter 3
(The TWAIN Dialog Box) for enhancement and filter details.

Scanning Tutorial 27
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@ Position a Document

For the best possible image scans, it is important that you position
your documents correctly and carefully.

2-3

1. Lift the document cover.

2. Place the document face down on the glass and in the upper right
cormer where the alignment marks are located.

3. Slowly lower the document cover, making sure the document

remains 11 position.

4. In your scanning program, set up the scanning parameters such as

scan mode and resclution.

5. Execute the scan command.

6. Remave the document after scanning is complete.

s TR IR
ot - -

Socument
Cover

Scan Window
Glass

Flatbed Scanner User's Guide
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€& Sca:ning Tips

The following tabies provide helpfi! information you can use when

setting the scan mode and/or resolution. Recommended scanning

resolutions for various cutput devices are listed as follows:

PRINTER INPUT  |SUGGESTED
TYPE | MATERIAL |scaN mopg | RESOLUTION
600-dpi Color Gmayscale 150 dpi
Laser or Grayscale Grayscale 150 dpi
Inkjet Printer] Line Art'Text| Line ArtText 600 dpi
300-dpi Color Grayscale 100 dpi
Laser or Grayscale Grayscale 100 dpi
Inkjet Pripter] Line Art/Text| Line Art/Text 300 dpi
Col Calor Cieck with
Color Inkjet oor mamdfacter for
Printer Grayscale Grayscale recormmended
Line ArtText| Line Art/Text .
resolution
" -
I'}ye ; Color Color Sean 3 nfzmmum
Sublimmation resolution of
or Coler Uffiﬁ:ﬁ quisr}mree « printer in al}
Laser Priater| o0 oo f 06 modes
Space requirements for different scan modes:
L]
Scan Size 4= X 6" Al
Resolution
e 100 | 300 | 600 [ 100 | 300 | 608
703 | 52 |[247| 28| 249|998
COLOR |5 (Mo | M8 [MB | Me | M
234 | 21 | 82 | 944 83 | 332
GRAY xe [ M8 [ me [ KB | MB | MB
293| 284 | 1.1 |118) 11 | 42
LINEART| (5| i@ [ me |« | M8 | m8
Scanning Tutorial
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The TWAIN Dialog Box

The TWAIN dialog box is part of the scanning module provided with
your scanner. TWAIN is an industry standard that allows scanning
directly into any TWAIN-compliant scftware. [t eliminates most
compatibility prablems associated with software and input devices

supplied by different vendors.

You can cail up the TWIAN dialog box from within any TWAIN-
compliant software such as the application software bundled with the
scanrer (e.g. iPhoto Plus 1.2 or 4.0). If you are zot continuing from
the “Scanning Tutoral” please refer to Chapter 2 {(Fg. 2-4) “How to

Get (Acquire) the Twain Dialog Box™ before proceeding.

Gean Mode

Scan Source T Ay .-
—

Scan Sixe . Custom . | -

Aesalubion T Trow -

: —_

Uul;-u.‘

The TWAIN dialog box consists of two sections - the left section
where most of the TWAIN control settings are found and the right

section, which is the Preview window. .
To Prescan an image, please refer to Chapter Z (pg.2-6) “Performing a

Simple Scan”.

The TWAIN Dialog Box 31
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The Preview Window and Buttons

The Preview window is where you can view the prescan image. The
first dme you want to scan a document, it is better that you do a

prescan. With the prescan image, you can then specify the final image
area to be included in the actual scan and/or apply the TWAIN imags-

enhancement commands and filters.

Crop Frame
QOutlimes the scan
area or region that
will be included in
the final scan.

R
- e B
POV

[PPSR S

« Help
Provides on-line help for the scanner and software functions.
-
+ Language Icon _
Selects the language you would like to view the screen in.

= ExitIcon
Exits the program.

* Prescan the Image
A Prescan is a quick low-resolution scan of the entire original
image. From this low-resolution scan you can get a clearer idea
of the image area you want to include when you click Scan. To

prescan, the steps are:

1. Place the document face down on the scan window glass.

2. Click on the Prescan button. After the scanner has
scanned the documnent, the scanned image will appear in the
Preview Window. From the Prescan image, you can naw set
the exact image area you wish to include in your final scan.

Flatbed Scanner User's Guide
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»  Scan
When vou click on the Scan button, the Scanner dialog box
displays the progress of your image transfer. When scanning is
over, the image will be displayed in the main screen of the host
software behind the Scanner dialog box. This provides the option
of doing additional scans without re-acquiring the Scanner dialog
box each time.

« Single Scan Button
When this button ts selected, you can only have one Crop
Frame (or rectangle) in the Preview window. With the Crop
Frame you can outline the image area you wish to scan. Click one
of the sides or corners of the Crop Frame and drag it out or in to
the desired length and width. To move the eatire Crop Frame,
position the mouse cursor inside it and drag with the left mouse
button.

« Batch Scan Button
Clicking on this button allows you to have multiple scans on any
part of your document using different control settings. A dialog
box opens. Please refer to the section, Using Batch Scan found in
this chapter (Pg.3-10) for more details.

«  Using the Zoom Toals
« The Zoom In tool doubles the magnification of the image
area. [n magnified view, you can then drag the Crop Frame
to the ex¥ct area you want to scan. Use the Zoom Qut tool

to shrink the image. .

The Image Setting Buttons

The Image Setting Buttons allow you to create scan settings for your
own convenience. Saving image settings allows you to use the same
settings again and again without the hassle of resetting all the image

options.

Load Button
Loads previously saved settings.

Save Button
Saves current image settings to 2 file.

The TWAIN Dialog Box 3-3
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Previous Buiton
Reloads the last saved image setting.

Reset Button
Returns the image settings to their default values.

Information Button
Simultanecusly shows the current control settings from all the TWAIN

folders.

TWAIN Control Settings

34

The Main Folder

The Main folder contains the control settings needed for specifying the
scanning parameters such as scan mode, scan source, resojution, ete,
These parameters will determine how the origiral image or document

Scan Moda : —-—C-ci;-_—‘_,l -

Scan Source T T Ralacres T o

Scan Size ) '\_-h-n—_"_'_'__:-/
1w

Rosolution ” -

Scan Mode .
The Scan Mode determines how the scanuer reads the origiral image

or document. When choosing a scan mode, it is wise to consider what
purpose the resulting scanned image will be used for.

Flathed Scanner User's Guide
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*+ LineArt
Use this mode to scan text documents for use in CCR
{Optical Character Racognition) cr when you wish to scan
black-and-white drawings.

= Gray
Select Gray to capture images in shades of gray. Our Gray
mode generates 10-bit {1024 shades of gray) intemal images

and 8-bit {256 shades of gray) external images.

s Color
Select Color to capture images in colors. Our Color mode
generates 30-bit (1.074 billion colors) internal images and
24-bit (16.7 million colors) external images.

Note: [nternal images refer to images that are originally
captured by the scanner. External images refer to images thar
are transferred to the computer.

Scan Source
The Scan Source setting is used to select the type of document you
will be scanning.
* Reflective _
Use Reflective when you wish to scan a paper-based
document such as photographs or text. :

Select the Scan Size

From the list of available paper sizes, select the size of the document
you wish to scan. Custorn will automatically be selected when you
use the Crop Frame to change the image area to be scanned.

Resolution '
The Resolution, which is measured in dots per inch (dpi) determines
the effect of the image as it is displayed or printed. Images scanned
at a higher resolution appear sharp since the scanner is capturing
more information but also take up more disk space for storage. You
can select from a wide range of preset resolutions.

The TWAIN Dialeog Box 3-5
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Output Scaling
Quiput scaling allows you to enlarge the size of the fina! cutput mage.
For example, setting the Output Scaling to 200% will enlarge the cutput

image four times its origmnal size.

Width and Height
The Width and Height values show the dimensions of the image area
inside the Crop Frame in the Preview window. You can change the

measurement uait to centimeters or inches.

Image Size

Image Size displays the amount of computer memory or disk space
needed to display or save the image outlined by the Crop Frame in the
Preview window. The Image Size informatiorn is automatically updated
anytime you change any of the control settings or resize the Crop Frame.

Descreen

Descreen is a useful tocl for reducing moiré patterns in
scanned images of originals that were created by a halftene
process. Moiré patterns appear as unsightly wnterference

patterns.

Flathed Scanner User's Guide
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The Enhancement Folder

The Enhancement folder contains preprocessing controls you can
apply to the image before making your final scan. Using these
preprocessing controls, you can alter the appearance of the final

output image. To view the Enhancement folder, click the Enhance tab.

T Mon | Enhancs | Flen | sboa Y
' s

Thumbnails

The Enhancerllent folder contains two thumbnails of the prescan
image, several control settings, and a histogram of the image. Changes
you make to the control settings will appear in the sample thumbnail.
If you wish to change the image that appears in the thumbnails, drag
the Crop Frame it the Preview window.

If you wish to see the effects of your changes in the Preview window
trmage, click on the Preview buttomn.

= Channel Selector
Channel refers to the red, green, and blue layers that make up
a color image. You can choose to change the channels
individually or choose Master to change all channels equally
and simultaneously. An image in Gray Mode has one channel.

+ Brightness Control

The Brightmess control allows you to adjust the overall
amount of light in the image.

The TWAIN Dialog Box 37




Canirast - Fl_-'_sl = Contrast Coatrol
e =l The Contrast control aillows you to adjust the overall amount
of white and black in the image.

* Gamma Control
The Gamma control i1s used for adjusting the brightness level
in the highlights, midtones, and shadows of the image. Values
of 0.1 to 2.0 primarily affect the shadow areas of the image.
Values of 2.1 to 6.0 primarily affect the midtone areas, and
values of 6.1 to 7.9 primarily affect the highlight areas.

+ Histogram Button
The histogram shows the distribution of the brightness levels
in the image. To adjust the display of the histogram, click on
the Histogram button and then click on the + or - button.

» Preview Button
Click the Preview button to see any changes made to the
image, The changes will appear in the Preview window image.

k The Filters Folder
The Filters folder contains preprocessing controls that allow you to -
apply special effects to the image before making your final scan. To
view the Filters folder, click the Filters tab.

The Filters folder contains two
thumbnails of a sample image. Any
filter you choose will immediately
show its effect in the sample thumb-
nail.

-8 Flathed Scanner User's Guide



* Nomne
The None setting means oo filter is applied. This is the
default setting.

* Blur

The Blur filter {controlled with the plus and minus buttons)
smoothes the irnage by lightening the pixels that are in sharp
contrast to their neighboring pixels.

* Sharpen
The Sharpen filter (controlled with the plus and minus
buttons) enhances the detail tn blurry images by improving the
focus and increasing the contrast in the imnge.

= Invert
The Invert filter reverses an image to its negative or
complimezt.

- Flip

The Flip filter creates a mirror image of the original by
flipping the image horizontally.

*  Unsharp Mask

The Unsharp Mask filter detects sharp edges and colcr
boundaries and then emphasizes them.

+« Emboss
The Emboss filter makes the elements in an image appear
raised or sunken.

About Folder

The About folder contains the current driver version number and the
copyright notice. To view the About folder, click the About tab.

The TWAIN Dialog Box 39




Using Batch Scan

3-10

Batch scanning is an easy way to multi-scan any part of
your document using different scan modes and resolutions (however,
certain application programs do not support this function). In batch

scanning, you can specify up to a maximum of 10 scan regions or you can

scan a single region several times using different combinations of scan
mades and resolutions.

To do a batch scan, the steps are:
1. Click on the Batch Scan button. The Batch Scan dialog box appears.

2. Create a scan regien:
(a) Move the cursor inside the preview window.

(b) Hold down the Shift key, press the teft mouse button and drag
the mouse to create a crop frame.,

(c) Reposition or resize the crop frame if necessary.

3. Set the desired scan mode and resolution for the current scan
region.

4. Repeat steps 2 and 3 if you wish to create more scan regions. You
can have up to 10 scan regions.

5. Click Scan. The scanner will begin to scan the scan regions one
after the other.

:
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-




Appendix A: Specifications*

Scanner Type Flatbed
Scan Modes True Color: 30bits (internal), 1.074 billioncolors
24bits (external), 16.7 mullion colors
Gray Mode: 10bits (internal), 1024 shades of gray
8 bits (external), 256 shades of gray
Text/Line Art:  1bit/pixel (2 levels)

' ScanMethod 1 scanning pass
’ Scan Area 8.5"x11.7"(216x297mm)
Resolution Optical: 300dpi{(H)x 600dpi (V)

- Maximum: 9600 dpix 9600 dpi (through software interpolation)

Scanning Data Buffer 32XB{maximum)

Brightness Control 255 adjustable steps (software controlled)

Caontrast Control 255 adjustable steps (software controlled)
. ‘v?%"*- Interface EPP
Dimensions 164"x 11.1"x2.5"(LxWxH)
416mmx 282 mmx 64 mm{L x Wx H)
Weight 5.11bs{23kg) ~
Voltage Requirements AC100V~120Vor200V~240),47~63 Hz Adapter
Power 12V DC mput

Operating Bumidity  20% to 80% RH, noncondensing

Operating Temperature 10 to 40 degrees Centigrade (50 to 104 degrees Fahrenheit)

Storage Temperature -10 to 60 degrees Centigrade (14 to 140 degrees Fahrenheit)

Storage Humidity 20% to 80% RH, noncondensing

* Product specifications are subject fo change without notice.

Appendix

A-1




